
 

 
 

TIA Portal Openness: 
Einführung und 
Demoanwendung  

 
TIA Portal V14 SP1 
 

https://support.industry.siemens.com/cs/ww/de/view/108716692  

  
 

Siemens 
Industry 
Online 
Support  

https://support.industry.siemens.com/cs/ww/de/view/108716692


Gewährleistung und Haftung 

 

TIA Portal Openness 
Beitrags-ID: 108716692,    V1.2,    05/2017   2 
 

â
 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Gewährleistung und Haftung 
 

Hinweis Die Anwendungsbeispiele sind unverbindlich und erheben keinen Anspruch auf 
Vollständigkeit hinsichtlich Konfiguration und Ausstattung sowie jeglicher Eventualitäten. 
Die Anwendungsbeispiele stellen keine kundenspezifischen Lösungen dar, sondern sollen 
lediglich Hilfestellung bieten bei typischen Aufgabenstellungen. Sie sind für den 
sachgemäßen Betrieb der beschriebenen Produkte selbst verantwortlich. Diese 
Anwendungsbeispiele entheben Sie nicht der Verpflichtung zu sicherem Umgang bei 
Anwendung, Installation, Betrieb und Wartung. Durch Nutzung dieser 
Anwendungsbeispiele erkennen Sie an, dass wir über die beschriebene Haftungsregelung 
hinaus nicht für etwaige Schäden haftbar gemacht werden können. Wir behalten uns das 
Recht vor, Änderungen an diesen Anwendungsbeispiele jederzeit ohne Ankündigung 
durchzuführen. Bei Abweichungen zwischen den Vorschlägen in diesem 
Anwendungsbeispiel und anderen Siemens Publikationen, wie z. B. Katalogen, hat der 
Inhalt der anderen Dokumentation Vorrang. 

Für die in diesem Dokument enthaltenen Informationen übernehmen wir keine 
Gewähr. 
Unsere Haftung, gleich aus welchem Rechtsgrund, für durch die Verwendung der 
in diesem Anwendungsbeispiel beschriebenen Beispiele, Hinweise, Programme, 
Projektierungs- und Leistungsdaten usw. verursachte Schäden ist ausgeschlossen, 
soweit nicht z. B. nach dem Produkthaftungsgesetz in Fällen des Vorsatzes, der 
groben Fahrlässigkeit, wegen der Verletzung des Lebens, des Körpers oder der 
Gesundheit, wegen einer Übernahme der Garantie für die Beschaffenheit einer 
Sache, wegen des arglistigen Verschweigens eines Mangels oder wegen 
Verletzung wesentlicher Vertragspflichten zwingend gehaftet wird. Der Schadens-
ersatz wegen Verletzung wesentlicher Vertragspflichten ist jedoch auf den 
vertragstypischen, vorhersehbaren Schaden begrenzt, soweit nicht Vorsatz oder 
grobe Fahrlässigkeit vorliegt oder wegen der Verletzung des Lebens, des Körpers 
oder der Gesundheit zwingend gehaftet wird. Eine Änderung der Beweislast zu 
Ihrem Nachteil ist hiermit nicht verbunden. 
Weitergabe oder Vervielfältigung dieser Anwendungsbeispiele oder Auszüge 
daraus sind nicht gestattet, soweit nicht ausdrücklich von der Siemens AG 
zugestanden. 

 

Security-
hinweise 

Siemens bietet Produkte und Lösungen mit Industrial Security-Funktionen an, die den 
sicheren Betrieb von Anlagen, Systemen, Maschinen und Netzwerken unterstützen. 

Um Anlagen, Systeme, Maschinen und Netzwerke gegen Cyber-Bedrohungen zu sichern, 
ist es erforderlich, ein ganzheitliches Industrial Security-Konzept zu implementieren (und 
kontinuierlich aufrechtzuerhalten), das dem aktuellen Stand der Technik entspricht. Die 
Produkte und Lösungen von Siemens formen nur einen Bestandteil eines solchen 
Konzepts. 

Der Kunde ist dafür verantwortlich, unbefugten Zugriff auf seine Anlagen, Systeme, 
Maschinen und Netzwerke zu verhindern. Systeme, Maschinen und Komponenten sollten 
nur mit dem Unternehmensnetzwerk oder dem Internet verbunden werden, wenn und 
soweit dies notwendig ist und entsprechende Schutzmaßnahmen (z.B. Nutzung von 
Firewalls und Netzwerksegmentierung) ergriffen wurden.  

Zusätzlich sollten die Empfehlungen von Siemens zu entsprechenden Schutzmaßnahmen 
beachtet werden. Weiterführende Informationen über Industrial Security finden Sie unter 
http://www.siemens.com/industrialsecurity.  

Die Produkte und Lösungen von Siemens werden ständig weiterentwickelt, um sie noch 
sicherer zu machen. Siemens empfiehlt ausdrücklich, Aktualisierungen durchzuführen, 
sobald die entsprechenden Updates zur Verfügung stehen und immer nur die aktuellen 
Produktversionen zu verwenden. Die Verwendung veralteter oder nicht mehr unterstützter 
Versionen kann das Risiko von Cyber-Bedrohungen erhöhen.  

Um stets über Produkt-Updates informiert zu sein, abonnieren Sie den Siemens Industrial 
Security RSS Feed unter http://www.siemens.com/industrialsecurity. 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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1 Aufgabe 

Einführung 

In STEP 7 bzw. WinCC V14 SP1 ist TIA Portal Openness im Lieferumfang von 
STEP 7 bzw. WinCC im TIA Portal enthalten. Damit können Sie Anwendungen 
programmieren, die das Engineering im TIA Portal automatisieren. 

 

Überblick über die Automatisierungsaufgabe 

Abbildung 1-1 

Import/ 
Export

Eigenes 
Programm

Öffentliche API

 

Szenarien 

¶ Anhand von einer Textdatenbank sollen Projekttexte automatisch 
programmgesteuert übersetzt und im TIA Portal Projekt übernommen werden. 
So können Sie standardisierte Texte schnell in neuen Projekten verwenden. 

¶ Mit Hilfe von exportierten PLC-Daten soll die Visualisierung automatisch 
erstellt werden. 

¶ Projektstatistiken oder -sicherungen können automatisch erstellt werden. Mit 
Hilfe Ihres Programmes können Sie überprüfen, ob Programmierrichtlinien 
eingehalten wurden. 

¶ Projekte können automatisch mit globalen Bibliotheken abgeglichen und bei 
Bedarf aktualisiert und übersetzt werden. 

¶ Das Offline-Projekt kann automatisch mit den Online-Projekten verglichen 
werden, um die Anlagenkonsistenz sicherzustellen. 

¶ Mit Hilfe eines Tools sollen Gesamtprojekte anhand von vorgefertigten 
Projektteilen erstellt werden. 
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2 Lºsung 

2.1 Übersicht 

Vorteile 

Die hier vorgestellte Lösung bietet Ihnen folgende Vorteile 

¶ Mehr Effizienz durch schnellere Ausführung der Aufgabe 

¶ Fehlerfreiheit durch Automatisierung gleichbleibender Prozesse 

¶ Kurze IBN-Zeiten durch programmgestützte Konfigurationserstellung 

¶ Wettbewerbsfähigkeit durch gezielteren Einsatz der Ressourcen 

 

Abgrenzung 

Dieses Anwendungsbeispiel enthält keine Beschreibung von: 

¶ Grundlagen zur objektorientierten Programmierung 

¶ Grundlagen zur Programmierumgebung, wie z.B. Microsoft Visual Studio 

¶ Grundlagen zur TIA Portal Projektierung 

Grundlegende Kenntnisse über diese Themen werden vorausgesetzt. 

 

2.2 Hard- und Software-Komponenten 

2.2.1 Gültigkeit 

Dieses Anwendungsbeispiel ist gültig für 

¶ STEP 7 / WinCC TIA Portal V14 SP1 

 

2.2.2 Verwendete Komponenten 

Das Anwendungsbeispiel wurde mit den nachfolgenden Komponenten erstellt: 

 

Software-Komponenten 

Tabelle 2-1 

Komponente Anz. Artikelnummer Hinweis 

STEP 7 Professional 
V14 SP1 

1 6ES7822-1AA04-0YA5  

WinCC Advanced 
V14 SP1 

1 6AV2102-0AA04-0AA5  

TIA Portal Openness 1  Im Lieferumfang von STEP 7 
bzw. WinCC V14 SP1 enthalten 
(Im Unterordner "Support" der 
Installationsdateien) 

Microsoft Visual 
Studio 2015 

1   
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Beispieldateien und Projekte  

Die folgende Liste enthält alle Dateien und Projekte, die in diesem Beispiel 
verwendet werden. 

 

Tabelle 2-2 

Komponente Hinweis 

108716692_TiaPortalOpennessDemo_V14SP1.
zip 

Demoanwendung zur Verwendung von 
TIA Portal Openness (siehe Kapitel 6) 

108716692_StartOpenness_V14SP1.zip Einführungsbeispiel zur Verwendung 
von TIA Portal Openness (siehe Kapitel 
5) 

108716692_TIA_Openness_GettingStartedAnd
Demo_V14SP1_de.pdf 

Dieses Dokument. 

 

 



3 Funktionsweise 
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3 Funktionsweise 

3.1 TIA Portal Openness 

In STEP 7 / WinCC V14 SP1 ist TIA Portal Openness kostenfrei auf den 
entsprechenden Produkt-DVDs vorhanden. Voraussetzung für die Nutzung ist eine 
Installation von STEP 7 bzw. WinCC V14 SP1. 

TIA Portal Openness stellt Ihnen DLLs zur Verfügung, über die Sie auf die TIA 
Portal Plattform zugreifen können. Diese DLLs basieren auf .NET Framework 
4.6.1. 

3.1.1 Funktionsumfang 

Tabelle 3-1 

Gerät Funktion siehe 
Weitere Informationen / 

Einschränkungen 

Projektweit TIA Portal öffnen S. 24  

Projektweit TIA Portal schließen/trennen S. 25  

Projektweit TIA Portal Prozess verbinden S. 24  

Projektweit Projekt öffnen S. 26  

Projektweit Projekt speichern S. 26  

Projektweit Projekt schließen S. 26  

Projekweit Geräte und Subnetze 
enumerieren 

S. 27  

Projektweit Netzwerk- und 
Topologieeditor öffnen 

S. 27  

Projektweit Ordner anlegen S. 28  

Projektweit Elemente löschen S. 29  

Projektweit Projektgrafiken exportieren, 
importieren, 

S. 29  

    

Bibliotheken Globale Bibliothek öffnen S. 31  

Bibliotheken Globale Bibliothek schließen S. 31  

Bibliotheken Typen: Updateprüfung der 
Instanzen 

S. 32  

    

HMI Hardware und/oder Software 
übersetzen 

S. 29  

HMI Bilder als XML exportieren S. 29 Einschränkungen: TIA Portal 
Openness Hilfe Kap. 8.3.7.1 
Übersicht der exportierbaren Bild-
Objekte 

HMI Bilder aus XML importieren S. 29  

HMI Elemente der Bildverwaltung 
als XML exportieren 

S. 29 Ausnahme: Pop-Up und Slide-In-
Windows 

HMI Elemente der Bildverwaltung 
aus XML importieren 

S. 29 Ausnahme: Pop-Up und Slide-In-
Windows 

HMI Variablen/Variablentabellen 
als XML exportieren 

S. 29  

HMI Variablen/Variablentabellen 
aus XML importieren 

S. 29  
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Gerät Funktion siehe 
Weitere Informationen / 

Einschränkungen 

HMI Verbindungen als XML 
exportieren 

S. 29 Nichtintegrierte Verbindungen 

HMI Verbindungen aus XML 
importieren 

S. 29 Nichtintegrierte Verbindungen 

HMI Skripte als XML exportieren S. 29  

HMI Skripte aus XML importieren S. 29  

HMI Zyklen als XML exportieren S. 29  

HMI Zyklen aus XML importieren S. 29  

HMI Text- und Grafiklisten als 
XML exportieren 

S. 29  

HMI Text- und Grafiklisten aus 
XML importieren 

S. 29  

    

PLC Hardware und/oder Software 
übersetzen 

S. 29  

PLC Steuerung online 
verbinden/trennen 

S. 32  

PLC Online/Offline Vergleich S. 33  

PLC Offline/Offline Vergleich S. 33  

PLC Bausteine im Editor anzeigen S. 27  

PLC Bausteine als XML 
exportieren 

S. 29 Keine SCL-Bausteine 

PLC Bausteine aus XML 
importieren 

S. 29  

PLC Externe Quellen importieren S. 33  

PLC Bausteine aus Quellen 
generieren 

S. 34  

PLC Quellen aus Bausteinen 
erstellen 

S. 34 AWL- und SCL-Bausteine 

PLC Variablentabellen und 
Datentypen im Editor 
anzeigen 

S. 27  

PLC Variablentabellen und 
Datentypen als XML 
exportieren 

S. 29  

PLC Variablentabellen und 
Datentypen als XML 
exportieren 

S. 29  

PLC Einzelne Variable exportieren S. 29  
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3.1.2 Einschränkungen 

¶ Mit TIA Portal Openness V14 SP1 können Sie nur auf Projekte und 
Bibliotheken mit der Version V14 SP1 zugreifen. Rüsten Sie bei Bedarf Ihr 
Projekt bzw. Ihre Bibliothek vor der Verwendung mit TIA Portal Openness 
hoch. 

¶ Es kann keine Kompatibilität zwischen den TIA Portal Openness Versionen 
gewährleistet werden. Eventuell sind mit einer neuen Version Änderungen in 
Ihrem Programm notwendig. 

¶ Derzeit ist es nicht möglich über TIA Portal Openness auf die WinCC Runtime 
Professional-Projektierung oder auf Daten von Startdrive-Objekten 
zuzugreifen. 

3.2 Beispielanwendung "StartOpenness" 

Das Programm "StartOpenness" soll Ihnen den Einstieg zur Programmierung Ihrer 
ersten eigenen Openness Applikation erleichtern.  

In dem Programm sind einige grundlegende Funktionen bereits programmiert (z.B. 
TIA Portal starten), sodass Sie darauf aufbauend Ihre eigene Anwendung 
weiterentwickeln können. 

 

3.3 Beispielanwendung "DemoOpenness" 

Das Programm "Demo_Openness" enthält viele ausprogrammierte Funktionen von 
TIA Portal Openness. Es soll Ihnen einen Funktionsüberblick, sowie detailliertere 
Programmierhilfe bieten. 



4 Erstellung einer neuen TIA Portal Openness Applikation 
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4 Erstellung einer neuen TIA Portal 
Openness Applikation 

4.1 TIA Portal Openness installieren 

Sie können TIA Portal Openness über die Produkt-DVD installieren. 

 

Tabelle 4-1 

Nr. Aktion 

1.  Öffnen Sie die STEP 7 bzw. WinCC V14 SP1 Produkt-DVD. Starten Sie das 
Installations-Setup "Siemens_TIA_Openness_V14SP1.exe" im Ordner "Support". 

2.  Folgen Sie den Anweisungen des Installations-Setup. 

 

4.2 Benutzerrechte verwalten 

Um eine TIA Portal Openness Applikation zu nutzen bzw. zu erstellen muss der 
Benutzer zur Benutzergruppe "Siemens TIA Openness" hinzugefügt werden. 

Tabelle 4-2 

Nr. Aktion 

1.  Klicken Sie in der Windows-Startleiste mit der rechten Maustaste auf "Computer" 
und wählen Sie "Verwalten" ("Manage"). 

 

2.  Öffnen Sie "Lokale Benutzer und Gruppen > Benutzer" und doppelklicken Sie auf 
den Benutzer. 
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Nr. Aktion 

3.  Wechseln Sie in die Registerkarte "Mitglied von" ("Member Of") und klicken Sie 
die Schaltfläche "Hinzufügen" ("Add"). 

 

4.  Geben Sie "Siemens TIA Openness" ein und bestätigen Sie mit "OK". 

 

5.  Schließen Sie die geöffneten Dialoge und melden Sie sich neu an. 
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4.3 Projekt anlegen 

Tabelle 4-3 

Nr. Aktion 

1.  Erstellen Sie ein neues Projekt (z.B. in Microsoft Visual Studio). 

2.  Legen Sie Referenzen zu den Openness DLLs (Siemens.Engineering.dll und 
Siemens.Engineering.HMI.dll) an. Diese befinden sich im TIA Portal 
Installationsverzeichnis unter "... > Siemens > Automation > Portal V14 > 
PublicAPI > V14 SP1".  

3.  Stellen Sie die Eigenschaft "Lokale Kopie" ("Copy Local") beider DLLs auf 
"False". 
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4.4 Konfigurationsdatei / AssemblyResolve 

Zur Ermittlung des Pfades zu den Openness DLLs können Sie entweder eine 
Konfigurationsdatei oder das Ereignis "AssemblyResolve" verwenden.  

Tabelle 4-4 

Nr. Aktion 

1.  Konfigurationsdatei 

Falls Sie bei der Installation von WinCC bzw. STEP 7 (TIA Portal) einen anderen 
als den Standardpfad gewählt haben, ersetzen Sie den Standardpfad in der 
Konfigurationsdatei durch Ihren Installationspfad. 

Legen Sie die Anwendungskonfigurationsdatei im gleichen Verzeichnis wie die 
Openness-Anwendung ab. 

2.  AssemblyResolve 

Um die Verbindung zum TIA Portal herzustellen, können Sie die Methode 
"AssemblyResolve" verwendet. 

 

Der Installationspfad des TIA Portals wird dabei aus der Registry ausgelesen, 
damit das Programm unabhängig vom Installationspfad verwendet werden kann. 
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4.5 Zugriff gewähren 

Tabelle 4-5 

Nr. Aktion 

1.  Beim ersten Start Ihrer Anwendung erscheint folgende Sicherheitsmeldung: 

 
Quelle: Systemhandbuch 
(https://support.industry.siemens.com/cs/ww/de/view/109477163) 

2.  Bestätigen Sie die Meldung mit "Ja", um den Zugriff einmalig zu erlauben. 

Bestätigen Sie die Meldung mit "Ja, alle", um den Zugriff für diese Anwendung 
immer zu erlauben. 

Klicken Sie "Nein", um den Zugriff zu verweigern. 

 

Hinweis Wenn Sie mit Microsoft Visual Studio arbeiten, kann es vorkommen, dass Sie die 
Meldung erhalten, obwohl Sie bereits "Ja, alle" geklickt haben. Um dies zu 
vermeiden, folgen Sie den Anweisungen im Beitrag \5\. 

 

 

https://support.industry.siemens.com/cs/ww/de/view/109477163


5 Start Openness 
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5 Start Openness 

5.1 Übersicht 

Das Programm "StartOpenness" soll Ihnen den Einstieg zur Programmierung Ihrer 
ersten eigenen Openness Anwendung erleichtern.  

 

Hinweis Sie finden eine fertig kompilierte "exe"-Datei im Download 
"108716692_StartOpenness_V14SP1.zip" unter dem Pfad 
"é\StartOpenness\StartOpenness\bin\Debug". 

 

Abbildung 5-1 

 

 

Über das Textfeld (1) werden Statusinformationen ausgegeben. 

1 



5 Start Openness 
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Tabelle 5-1 

Nr. Aktion 

1.  Öffnen Sie das Projekt "StartOpenness". 

2.  Öffnen Sie die Klasse "Form1". 

 

3.  Um die Verbindung zum TIA Portal herzustellen, wurde die Methode 
"AssemblyResolve" verwendet. 

4.  Es wurden zwei Variablen angelegt: 

¶ "MyTiaPortal" vom Typ "TiaPortal" 

¶ "MyProject" vom Typ "Project" 
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5.2 Gruppe "TIA Portal" 

Abbildung 5-2 

 

 

Tabelle 5-2 

Nr. Beschreibung 

1.  Wählen Sie über die Optionsfelder "With User Interface" und "Without User 
Interface", ob das TIA Portal mit oder ohne Benutzeroberfläche gestartet werden 
soll. 

In der Methode "StartTIA()" wird der Zustand der Optionsfelder abgefragt. 

 

2.  Klicken Sie die Schaltfläche "Start TIA", um das TIA Portal zu starten. 

Die Methode "StartTIA()" wird aufgerufen. 

Der Variable "MyTiaPortal" wird eine neue TiaPortal Instanz zugewiesen. 

 

3.  Klicken Sie die Schaltfläche "Dispose TIA", um das TIA Portal bzw. die 
Verbindung zum TIA Portal zu beenden. 

Die Methode "DisposeTIA()" wird aufgerufen. 

Über "mytiaportal.Dispose()" wird die Verbindung zum TIA Portal beendet (wenn 
das TIA Portal mit Benutzeroberfläche gestartet wurde) bzw. das TIA Portal 
beendet (wenn das TIA Portal ohne Benutzeroberfläche gestartet wurde). 

 

 

1 

2 

3 
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5.3 Gruppe "Project" 

Abbildung 5-3 

 

Tabelle 5-3 

Nr. Beschreibung 

1.  Klicken Sie die Schaltfläche "Open Project", um ein neues Projekt zu öffnen. 
Wählen Sie im Dateibrowser das Projekt aus, das Sie öffnen möchten. 

Die Methode "SearchProject()" wird aufgerufen. 

Der Dateibrowser wird geöffnet. Wurde ein Projekt ausgewählt, wird die Methode 
"OpenProject()" aufgerufen. 

 
Über "MyTiaPortal.Projects.Open(new FileInfo(ProjectPath))" wird die 
Projektvariable "MyProject" initialisiert. 

 

2.  Klicken Sie die Schaltfläche "Connect to Open TIA Project", um sich mit einem 
geöffneten TIA Projekt zu verbinden. 

 

3.  Klicken Sie die Schaltfläche "Save Project", um das Projekt zu speichern. 

Die Methode "SaveProject()" wird aufgerufen. 

Über "MyProject.Save()" wird das Projekt gespeichert. 

 

1 

2 

3 

4 
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Nr. Beschreibung 

4.  Klicken Sie die Schaltfläche "Close Project", um das Projekt zu schließen. 

Die Methode "CloseProject()" wird aufgerufen. 

Über "MyProject.Close()" wird das Projekt geschlossen. 

 

5.4 Gruppe "Add" 

 

Abbildung 5-4 

 

 

Tabelle 5-4 

Nr. Beschreibung 

1.  Geben Sie im Textfeld den Namen des Gerätes ein, das Sie hinzufügen 
möchten. 

2.  Geben Sie im Textfeld die Bestellnummer des Gerätes ein, das Sie hinzufügen 
möchten. 

3.  Geben Sie im Textfeld die Version des Gerätes ein, das Sie hinzufügen möchten. 

4.  Klicken Sie die Schaltfläche "Add Device", um das Gerät hinzuzufügen. 

Die Methode "btn_AddHW_Click()" wird aufgerufen. 

Wurde kein Gerät mit dem eingegebenen Namen gefunden, wird das Gerät 
hinzugefügt und im Statusfeld ausgegeben. 

 

1 

2 

3 

4 
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5.5 Gruppe "Compile" 

Abbildung 5-5 

 

 

Tabelle 5-5 

Nr. Beschreibung 

5.  Geben Sie im Textfeld den Namen der Steuerung bzw. des Bediengerätes ein, 
das Sie übersetzen möchten. 

In der Methode Compile() wird der Name aller Devices und deren DeviceItems 
mit dem eingegebenen Namen verglichen. 

 

6.  Klicken Sie die Schaltfläche "Compile", um das Gerät zu übersetzen. 

Die Methode "Compile()" wird aufgerufen. 

Wurde eine Steuerung oder ein Bediengerät mit diesem Namen gefunden, wird 
das Gerät übersetzt. Das Ergebnis wird in der Variable "result" vom Typ 
"CompilerResult" gespeichert und über das Statusfeld ausgegeben. 

 

 

1 

2 
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6 TIA Openness Demo 

6.1 Allgemeines 

Die Anwendung "TIAPortalOpennessDemo" besteht aus zwei Projekten. 

¶ TiaOpennessHelper 
Einige, vor allem wiederkehrende, Methoden wurden in der 
"TiaOpennessHelper" realisiert. Mit Hilfe einer Referenz auf 
"TiaOpennessHelper.dll" können Sie diese Methoden in Ihren eigenen 
Anwendungen verwenden.  

¶ TIAPortalOpennessDemo 
Die Demoanwendung soll Ihnen einen Überblick über die mit TIA Portal 
Openness nutzbaren Funktionen bieten. Durch die vielen ausprogrammierten 
Beispiele dient die Anwendung aber auch zur detaillierten Hilfe beim 
Programmieren. 

Im Folgenden finden Sie zwei Verzeichnisse, die Ihnen den Umgang mit der 
Anwendung erleichtern sollen. Wenn Sie nach einer spezifischen Funktion bzw. 
nach einer spezifischen Anwendung suchen, können Sie eines der folgenden 
Verzeichnisse nutzen. 

Um die Beschreibung nachzuvollziehen, starten Sie das Programm 
"TIAPortalOpennessDemo.exe" und öffnen Sie das Projekt mit Microsoft Visual 
Studio. 

 

Hinweis Sie finden eine fertig kompilierte "exe"-Datei im Download 
"108716692_TiaPortalOpennessDemo_V14SP1.zip" unter dem Pfad 
"é\108716692_TiaPortalOpennessDemo_V14SP1 
\TIAPortalOpennessDemo\TIAPortalOpennessDemo\bin\Release". 

 

6.2 Anwendungsbeispiele 

AssemblyResolve .............................................................................. 24 

TIA Portal starten ...............................................................................  24 

Mit aktiver TIA Portal Instanz verbinden ............................................ 24 

Von TIA Portal trennen ......................................................................  25 

Projekt öffnen/speichern/schließen ....................................................  26 

Geräte auslesen .................................................................................  27 

Editoren öffnen ...................................................................................  27 

Ordner anlegen ..................................................................................  28 

Elemente löschen ..............................................................................  29 

Elemente übersetzen ......................................................................... 29 

Objekte importieren/exportieren ........................................................ 29 

Globale Bibliotheken öffnen/schließen ..............................................  31 

Updateprüfung ...................................................................................  32 

Online-Verbindung zur Steuerung ..................................................... 32 

Steuerungen vergleichen ................................................................... 33 
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Externe Quellen einbinden ................................................................ 33 

Baustein aus Quelle erzeugen ........................................................... 34 

Quelle aus Baustein erzeugen ........................................................... 34 

6.3 Methoden 

CompareTo(Object) ........................................................................... 33 

CompareToOnline() ........................................................................... 33 

CreateFromFile() ................................................................................ 34 

Delete() .............................................................................................. 29 

ShowInEditor ...................................................................................... 28 

Compile() ........................................................................................... 29 

Dispose() ............................................................................................ 25 

Export() .............................................................................................. 30 

Groups.Create(FolderName) ............................................................. 28 

GenerateBlockFromSource() ............................................................. 34 

GenerateSource() .............................................................................. 34 

TiaPortal.GetProcesses() .................................................................. 25 

GlobalLibraries.Open()....................................................................... 32 

GoOffline() .........................................................................................  33 

GoOnline() .........................................................................................  33 

Import() .............................................................................................. 30 

Project.Close() ................................................................................... 26 

Project.Save() .................................................................................... 26 

Project.ShowHwEditor(Siemens.Engineering.HW.View.Network) .... 28 

Project.ShowHwEditor(Siemens.Engineering.HW.View.Topology) .. 28 

Projects.Open(new FileInfo()) ............................................................ 26 

process.Attach() ................................................................................. 25 

ShowInEditor ...................................................................................... 28 

TiaPortal ............................................................................................. 24 

UpdateCheck ..................................................................................... 32 
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6.4 Beschreibung der Anwendung 

6.4.1 Allgemeine Einstellungen 

Tabelle 6-1 

Nr. Aktion 

1.  Klicken Sie auf "File->Settings". 

 

 Das Fenster wird geöffnet. 

 

2.  Stellen Sie ein, ob das TIA Portal mit oder ohne Benutzeroberfläche gestartet 
werden soll ("TIA Portal user interface" "on" bzw. "Off"). 

3.  Wählen Sie die Export-Einstellungen ("Export options"). 

4.  Wählen Sie den Standardpfad für die Export- und Import-Dateien ("Default export 
path"). 

5.  Klicken Sie auf die Schaltfläche "Save", um die Einstellungen zu speichern. 
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6.4.2 AssemblyResolve 

Öffnen Sie die Klasse "General.cs" des Projektes "TiaOpennessHelper".  

Damit Sie die Anwendung auf jedem PC mit TIA Portal nutzen können, wird der 
TIA Portal Installationspfad aus der Registry ausgelesen, und so flexibel 
übergeben. 

 

6.4.3 TIA Portal Funktionen 

TIA Portal starten 

Über "File > Start TIA Portal" können Sie eine neue TIA Portal-Instanz öffnen. 
Abhängig von Ihren Einstellungen wird das TIA Portal mit oder ohne 
Benutzeroberfläche gestartet.  

 

Abbildung 6-1 

 

 

Öffnen Sie die Methode "OpenTiaPortalCommand_Executed" in der Klasse 
"MainWindowViewModel.cs". 

Die Variable "_tiaPortal" vom Typ "TiaPortal" wird initialisiert. Mit dem Parameter 
"TiaPortalMode.WithoutUserInterface" bzw. "TiaPortalMode.WithUserInterface" 
legen Sie fest, ob das TIA Portal mit oder ohne Benutzeroberfläche gestartet wird. 

Mit aktiver TIA Portal Instanz verbinden 

Über die Schaltfläche "File->Connect Portal" werden die aktiven TIA Portal 
Instanzen angezeigt.  

 

Abbildung 6-2 
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Abbildung 6-3 

 

 

Wählen Sie die gewünschte Instanz aus und klicken Sie auf "Select". Die 
Demoanwendung verbindet sich mit dieser Instanz. 

Öffnen Sie die Methode "CreateInstanceTreeView" in der Klasse 
"MainWindowViewModel.cs". 

Dazu wird die Methode "TiaPortal.GetProcesses()" verwendet. 

In der Methode "ShowConnectCommand_Executed" wird die Verbindung zur 
ausgewählten Instanz hergestellt. 

Dazu wird der TIA Portal Variable mittels "process.Attach()" ein Wert zugewiesen. 

Von TIA Portal trennen 

Über "File > Dispose TIA Portal" können Sie die Verbindung zur TIA Portal-Instanz 
wieder beenden. Wenn Sie die TIA Portal-Instanz ohne Benutzeroberfläche 
gestartet haben, wird die Instanz beendet. Ansonsten wird die Verbindung 
zwischen Ihrer Applikation und der TIA Portal-Instanz beendet. 

 

Abbildung 6-4 

 

 

Öffnen Sie die Methode "DisposeTiaPortalCommand_Executed" in der Klasse 
"MainWindowViewModel.cs". 

Über die Methode "Dispose()" der TIA Portal Variable wird die Verbindung 
getrennt. 
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6.4.4 Projektfunktionen 

Projekt öffnen/speichern/schließen 

Wenn noch kein Projekt geöffnet ist, können Sie über "File > Open Project" ein 
Projekt öffnen. 

Abbildung 6-5 

 

Öffnen Sie die Methode "OpenProjectCommand_Executed" in der Klasse 
"MainWindowViewModel.cs". 

Dazu wird eine Variable vom Typ "Project" mit der Methode .Projects.Open(new 
FileInfo()) der TIA Portal Variable initialisiert. 

Wenn ein TIA Portal Projekt geöffnet ist, können Sie über "File > Save Project" 
bzw. "File > Close Project" das Projekt speichern bzw. schließen. 

 

Abbildung 6-6 

 

 

Öffnen Sie die Methode "SaveProjectCommand_Executed" bzw. 
"CloseProjectCommand_Executed" in der Klasse "MainWindowViewModel.cs". 

Über die Methode "Project.Save()" bzw. "Project.Close()" der Projektvariable wird 
das Projekt gespeichert bzw. geschlossen. 
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Geräte auslesen 

Auf der linken Seite der Anwendung werden, ähnlich zum Projektbaum im TIA 
Portal, die Geräte und deren Elemente angezeigt. 

Abbildung 6-7 

 

 

Dazu werden alle im Projekt enthaltenen "Devices" und deren "DeviceItems" 
ausgelesen. 

Öffnen Sie die Klasse "General.cs" im Projekt "TiaOpennessHelper". 

In dieser Klasse werden die Projektinhalte ausgelesen und als Auflistungen 
bereitgestellt.  

In der Klasse "MainWindowViewModel.cs" des Projektes 
"TIAPortalOpennessDemo" wird in der Methode "CreateDeviceTreeViewItem()" auf 
diese Auflistungen zugegriffen. 

Beachten Sie bei der Auflistung der Elemente folgendes: 

¶ Viele Elemente können sich in benutzerdefinierten Ordnern befinden. Dabei ist 
die Schachtelungstiefe nicht unbedingt bekannt. Die Funktionen sollten 
deshalb rekursiv sein. 

Editoren öffnen 

Über "Project > Editor" können Sie den Topologie- und den Netzwerkeditor in der 
Benutzeroberfläche des TIA Portals starten.  

Abbildung 6-8 
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In der Klasse "MainWindowViewModel.cs" wird in der Methode 
OpenTopologyViewCommand_Executed() der Topologieeditor in der 
Benutzeroberfläche des TIA Portals gestartet. 

Über "Project.ShowHwEditor(Siemens.Engineering.HW.View.Topology)" bzw. 
"Project.ShowHwEditor(Siemens.Engineering.HW.View.Network)" können Sie den 
Topologie- und den Netzwerkeditor öffnen. 

Andere Editoren (z.B. den Bausteineditor) können Sie über das Menü "Project > 
Editor > Open editor" öffnen, wenn der Fokus auf einem entsprechenden Objekt 
liegt.  

Abbildung 6-9 

 

 

Öffnen Sie die Methode "OpenEditorCommand_Executed" in der Klasse 
"MainWindowViewModel.cs". 

Dazu wird an einem entsprechenden Objekt (z.B. einem Baustein) die Methode 
"ShowInEditor()" aufgerufen.  

Ordner anlegen 

Je nach Ihrer Auswahl im Projektbaum der TIA Portal Openness Applikation 
können Sie neue Ordner (z.B. Bausteinordner) anlegen.  

 

Abbildung 6-10 

 

 

Abbildung 6-11 

 

 

Öffnen Sie die Methode "CreateCommand_Executed" in der Klasse 
"MainWindowViewModel.cs". 

Über die Methode "Groups.Create(FolderName)" des ausgewählten Objektes wird 
ein neuer Ordner angelegt. Dazu wird vorher überprüft, ob im ausgewählten Objekt 
ein Ordner angelegt werden kann. 
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